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Chapter 47: Pro Tools Setup for Surround

Pro Tools HD let you work with surround formats 

up to 7.1. 

Surround Mixing in Pro Tools
(Pro Tools HD Only)

Pro Tools supports mixing in the following multi-

channel (greater than stereo) formats: LCR, Quad, 

LCRS, 5.0, 5.1, 6.0, 6.1, 7.0, 7.0 SDDS (Sony Dy-

namic Digital Sound), 7.1, and 7.1 SDDS.

Pro Tools Audio Connections 
for 5.1 Mixing

While all 5.1 mixing formats provide the same 

speaker arrangement, there are three primary stan-

dards in use for the track layout of the individual 

channels that comprise the 5.1-format multichan-

nel mix. 

In the following table, it is assumed that surround 

channels are assigned to outputs 1–6 of a Pro Tools 

audio interface. Use channels 7–8 to monitor a ste-

reo mix for a stereo version, or for cue mixes and 

monitoring. 

The following table shows the X-MON mono track 

routing for a 7.1 SDDS mix. A 5.1 mix should use 

the same routing, excluding outputs 2 and 4 (Lc 

and Rc).

For information on fundamental surround 
concepts, see the Pro Tools Sync & Surround 
Concepts Guide.

Track Layouts for 5.1 Formats

Formats Track Layout

1 2 3 4 5 6

Film 
(Pro Tools 

default)

L C R Ls Rs LFE

SMPTE/ITU 
for Dolby 

Digital (AC3)

L R C LFE Ls Rs

DTS L R Ls Rs C LFE

C|24 L C R Ls Rs Lf

Default Track Layout for 7.1 SDDS Format

Formats Track Layout

1 2 3 4 5 6 7 8

X-MON L Lc C Rc R Ls Rs LFE
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To connect your audio interfaces for 5.1 format 
mixing and monitoring:

1 Determine the 5.1 format and track layout you 
want to use. 

2 Connect the output channels of your audio in-
terface to the corresponding input channels of 
your monitoring system according to the assign-
ments listed in the tables above.

7.1 and 7.0 Formats

7.1 and 7.0 Format

HD-DVD and Blu-Ray systems use the following 
track layout for 7.1 and 7.0 surround formats: 

• 3 front channels (Left, Center, Right)

• 2 side channels (Left Surround Side, Right Sur-
round Side)

• 2 rear channels (Left Surround Rear, Right Sur-
round Rear)

• 1 LFE channel (x.1 formats only)

The following table shows the default mono track 
routing for a 7.1 mix in Pro Tools.

7.1 and 7.0 SDDS Formats

The Sony Dynamic Digital Sound (SDDS) 7.1 and 
7.0 surround formats use the following track lay-
out: 

• 5 front channels (Left, Left Center, Center, Right 
Center, Right)

• 2 rear channels (Left Rear, Right Rear)

• 1 LFE channel (x.1 formats only)

The following table shows default mono track 
routing for a 7.1 SDDS mix in Pro Tools. 

Configuring Pro Tools for 
Multichannel Sessions

Configuring Pro Tools and sessions for multichan-
nel mixing can be done in any (or all) of the fol-
lowing ways:

New Sessions

You can create a new session and choose a sur-
round mix I/O Settings file as the default 
I/O Setup. See “New Sessions and I/O Settings” on 
page 1063. 

Remixing Sessions in Surround (Importing 
Multichannel I/O Setups)

By creating or importing a surround mix I/O Set-
tings file in the I/O Setup dialog, multichannel 
paths can be made available in any stereo (or other 
format) session. You can then reassign track rout-
ing from the original stereo paths to multichannel 
paths. Inactive and active paths simplify reassign-
ment. See “Importing Multichannel I/O Setups” on 
page 1064.

If you use a control surface, see its guide for 
more information.

Default Track Layout for 7.1 Format

Track Layout

1 2 3 4 5 6 7 8

L C R Lss Rss Lsr Rsr LFE

Default Track Layout for 7.1 SDDS Format

Track Layout

1 2 3 4 5 6 7 8

L Lc C Rc R Ls Rs LFE
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Custom Multichannel Paths

You can customize and redefine existing paths in 
the I/O Setup dialog. For more information, see 
“Custom Multichannel Paths” on page 1065. 

Importing Session Data

By using the Import Session Data command (File > 
Import > Session Data), you can import tracks and 
media from other sessions plus their associated 
paths and track assignments. After importing ses-
sion data, you can use the I/O Setup dialog to con-
figure main and sub-paths for the requirements of 
the session. For more information, see Chapter 7, 
“I/O Setup.”

New Sessions and I/O Settings

When you create a new session, you can specify a 
surround format that you want to use as your 
I/O Setup. Default path configurations are 
provided as I/O Settings files, for stereo and 
surround mixing. 

Once you create the new session, you can create 
and import tracks, import audio, and assign signal 
routing to set up your mix. 

To create a new session for multichannel mixing:

1 Choose File > New Session.

2 Select the Create Blank Session option.

3 Select the Audio File Type, Sample Rate, and 
Bit Depth.

4 From the I/O Settings menu, select one of the 
following options: 

• 5.1 Film Mix 

• SMPTE/ITU 

• DTS Monitoring 

• C24 Mix 

• ICON X-MON Mix 

5 Click OK.

6 In the Save dialog, name the session, navigate to 
the location where you want to save the new 
session, and click Save.

The surround presets preconfigure the I/O Setup 
dialog for the new session with default 5.1 format 
main and sub-paths for outputs and busses.

To see multichannel options in Pro Tools, the 
Surround Mixer plug-in must be installed in 
the Plug-Ins folder. This plug-in can be in-
stalled with Pro Tools (see the User Guide 
for your Pro Tools system). If it is not in-
stalled, you can move it from the Plug-Ins 
(Unused) folder to the Plug-Ins folder.

New Session dialog, 5.1 Film Mix I/O setting selected

Standard 5.1 format (film) output paths
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Surround Mix Settings Files

The surround mix I/O Settings provide output and 

bus paths for six specific track layout standards in 

the new session. (For information on inputs and in-

sert paths, see “Default Input and Insert Paths with 

5.1 Settings” on page 1064.) 

All available 5.1 format (and greater) I/O Settings 

(Film, SMPTE/ITU, DTS, C24 Mix, or ICON X-

MON Mix) provide the following default output 

and bus paths for the new session:

Default 5.1 Output Paths

• One 5.1 main output path. 

• One stereo main path.

Default 5.1 Bus Paths

• One 5.1 main output bus path, with sub-paths for 

5.0 (no LFE), left/right (stereo), LCR, and center 

(mono). 

• One stereo main output bus path with two mono 

sub-paths.

Default Input and Insert Paths with 5.1 Settings

The 5.1 Mix settings files provide default stereo 

main paths and mono sub-paths for inputs and in-

serts. If you need multichannel input paths or in-

serts, you can create them in the I/O Setup (see 

“Custom Multichannel Paths” on page 1065). 

Importing Multichannel 
I/O Setups

The I/O Setup dialog can import and export set-

tings files. This is useful when you want to remix a 

stereo session in surround. You can also use this 

feature to prepare a session for transfer to a differ-

ent Pro Tools system, or to save and exchange 

I/O Settings. 

To import a multichannel I/O Setup settings file:

1 Choose Setup > I/O.

2 Click the Output tab.

3 Click Import Settings.

Settings Files and Track Layouts

5.1 Settings Track Layout

5.1 Film Mix L C R Ls Rs LFE

SMPTE/ITU Mix L R C LFE Ls Rs

DTS Mix L R Ls Rs C LFE

C24 Mix L C R Ls Rs Lf

ICON X-MON Mix L Lc C Rc R Ls Rs LFE

I/O Setup, Output page, default 5.1 (Film) Output 
assignments

I/O Setup, Bus page, default 5.1 (Film) Output Bus 
assignments
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4 Select the settings file (.pio) to import and click 
Open.

5 If the current session has path definitions that do 
not match those in the imported settings file, 
Pro Tools asks whether you want to delete the 
existing paths or retain them and add the im-
ported settings to your session. 

• Click No to add new paths to your current I/O 
Setup configuration.

• Click Yes to replace your current I/O Setup con-
figuration with the imported settings. 

6 Click the Bus tab.

7 If the Bus page does not show the correct output 
bus mappings for the imported I/O Settings file, 
click the Default button (for All Busses or for 
Output Busses).

8 Click OK to close the I/O Setup.

Exporting I/O Settings

Exporting I/O Setup settings files lets you build a 
library of multichannel setups for different proj-
ects. 

To export an I/O Setup settings file:

1 Choose Setup > I/O.

2 Click Export Settings.

3 Name and Save your current I/O Settings.

Custom Multichannel Paths

The I/O Setup dialog lets you create and customize 
signal paths for any supported multichannel mix-
ing format. 

Multichannel paths and sub-paths are assigned to 
input and output channels in the Channel Grid. 
When you select a preset 5.1 I/O Settings file, de-
fault layout for the corresponding multichannel 
format paths you create will match the selected for-
mat’s track layout. 

In addition, the I/O Setup dialog, like the Main 
page of the Hardware Setup dialog, provides con-
trols for routing the physical inputs and outputs on 
your audio interface to available inputs and outputs 
in Pro Tools.

Reassigning Channels

The I/O Setup dialog and its Channel Grid also let 
you reassign channels. This is especially useful for 
routing channels within a multichannel path, with-
out having to repatch your audio interfaces.

You can reassign paths to any required configura-
tion, limited only by your systems resources, and 
the I/O Setup dialog requirements for channel 
overlapping and naming (see “Valid Paths and Re-
quirements” on page 89 for more information).

When creating 5.1 format paths, you can 
specify the default track layout. See “Default 
Path Order for 5.1 Tracks” on page 1067. 

See also “Example Paths and Signal Routing 
for a Surround Mix” on page 1077. 
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Example LCRS Setup

The following example shows one possible way to 

configure the I/O Setup dialog to mix in 4-channel 

LCRS format, with an HD OMNI.

To define an LCRS path:

1 Choose Setup > I/O, and click the Output tab. 

2 Click New Path.

3 Select LCRS from the Path Format selector.

4 Name the path LCRS.

5 In the Channel Grid, click in the box below the 

first (left-most) audio interface channel for the 

path. Pro Tools automatically fills up the adja-

cent units to the right. If you click in the LCRS 

row under channel 1, the LCRS path will be as-

signed to channels 1–4. 

6 Click the Bus tab.

7 If the Bus page does not show the correct output 

bus mappings for the LCRS output, click the 

Default button (for All Busses or for Output 
Busses).

8 Select the new LCRS path and click the Reveal 

Sub-paths triangle.

9 If not all of the sub-paths are present, do the fol-

lowing:

• Click New Sub-Path.

• Name the new sub-path LCR and select LCR as 

the Path format. Click in channel 1 in the LCR 

row to assign the bus path.

• Select the LCRS path, click New Sub-Path, and 

create a stereo sub-path for front Left and front 

Right.

• Select the LCRS path, click New Sub-Path, and 

create a mono sub-path for the Center channel.

• Select the LCRS path, click New Sub-Path, and 

create a mono sub-path for the Surround chan-

nel.

10 Click OK to close the I/O Setup.

5.1 Tracks, Formats, 
Assignments, and Metering

Path definitions in I/O Setup determine how audio 

is routed through, and metered on, your audio in-

terfaces.

Pro Tools internal (on-screen) metering of 5.1 for-

mat paths always follows the Film track layout:

L C R Ls Rs LFE

Pro Tools track layout of 5.1 format audio tracks in 

the Edit window also conforms to the Film layout 

(arranged top to bottom). See “5.1 Track Layouts, 

Routing, and Metering” on page 1068

In the I/O Setup dialog, you can route these signals 

out of your audio interfaces according to any track 

layout (such as DTS or SMPTE/ITU). 

For additional I/O Setup information, see 
“Output Busses” on page 90. 

Output page, LCRS output path

Bus page, LCRS output bus with sub-paths
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To re-assign channels in a path:

� Drag a channel to a new valid location in the 

Grid. Other channel assignments will move 

(shuffle) to accommodate dragged channels.

Default I/O Selectors in I/O 
Setup

The Output page of the I/O Setup dialog provides 

selectors for setting I/O defaults in your multichan-

nel sessions.

Default Monitor Format Sets the default monitor 

format (Stereo, 5.1, or 7.1) for new Output paths 

and for when you click the Default button.

5.1 Path Order Selects the default track layout (or, 

path order) for new 5.1 format (six-channel) Out-

put paths.

Output Meter Path Selects the path that will be 

shown in the control surface output meters as well 

as in the Transport Output meters. See “5.1 Tracks, 

Formats, Assignments, and Metering” on 

page 1066 for more information.

Audition Paths Selects the monitoring path for 

previewing audio in the Clip List, Import Audio di-

alogs, and a Workspace browser. Only outputs on 

your primary interface can be used as your Audi-

tion path.

Default Output Bus Selects the default output bus 

path for all new tracks, for each supported track 

format. 

AFL/PFL Path (Pro Tools|HDX or Pro Tools|HD 
Native Systems Only) Selects where tracks are 

routed to when they are soloed in AFL (After 

Fader Listen) or PFL (Pre Fader Listen) Solo 

mode.

AFL/PFL Mutes (Output Path) (Pro Tools|HDX or 
Pro Tools|HD Native Systems Only) Selects 

which output is muted when AFL (After Fader Lis-

ten) or PFL (Pre Fader Listen) Solo mode is en-

abled, and a track is soloed.

Default Path Order for 5.1 
Tracks

You can specify the default track layout for all new 

5.1 format paths you create. 

To choose a new default 5.1-format path order 
(track layout):

1 Choose Setup > I/O. 

2 Click the Output tab.

3 Use the 5.1 Default Path Order setting to select 

the track layout you want (Film, SMPTE/ITU, or 

DTS Monitoring). 

Default selectors in the I/O Setup dialog

Default 5.1 Path Order I/O Setup Options

The New Track Default Output can be set to 
bus paths, as well as output paths.
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5.1 Track Layouts, Routing, and Metering

Track layout of different 5.1 formats

Channel Assignments in I/O Setup5.1 Format

Film 

SMPTE/ITU

DTS 

L C R Ls Rs LFE

(Control|24 Mix)

L R Ls Rs C LFE

L C R Ls Rs LFE

Track Meters Tracks

L C R Ls Rs LFE
(top to bottom)

L C R Ls Rs LFE
(left to right)

(Pro Tools Standard,

L C R Ls Rs LFE

L R C LFE Ls Rs

L R Ls Rs C LFE

L R C LFE Ls Rs

and C|24 Mix)

ICON X-MON
(8-channel 7.1)

L C R Ls Rs LFE
(top to bottom)

same same
L C R Ls Rs LFE

(left to right)

L x C x R Ls Rs LFE
L x C x R Ls Rs LFE

L C R Ls Rs LFE
same

L C R Ls Rs LFE
same

samesame
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Chapter 48: Multichannel Tracks and 
Signal Routing

Surround sessions typically include a combination 
of mono, stereo, and multichannel audio, Auxiliary 
Input, Master Fader, and Instrument tracks, and in-
serts and busses.

Once the appropriate I/O Setup has been imported 
or configured, audio, Auxiliary Input, Master 
Fader, and Instrument tracks can be mixed in mul-
tichannel for surround using Pro Tools mixing fea-
tures. 

Multichannel I/O and signal routing is determined 
by the paths defined in the I/O Setup dialog.

Multichannel Audio Tracks
(Pro Tools HD Only)

Multichannel audio tracks contain an individual 
channel for each signal in the track (for example, a 
5.1 track would have six channels for left, center, 
right, left surround, right surround, and LFE). 

Multichannel audio tracks can be:

• Recorded directly into Pro Tools, using multiple 
microphones or microphone arrays, or routed to 
appropriate multichannel Pro Tools Input paths

• Imported from other Pro Tools sessions

• Edited, processed, and mixed in combination 
with mono and stereo tracks

5.1 format audio files and tracks conform to the 
Film track layout standard. Regardless of path as-
signments in the I/O Setup dialog, all 5.1 format 
audio tracks and meters follow the Film standard 
track layout:

L C R Ls Rs LFE 

Multichannel surround mixing is supported 
with Pro Tools HD only.

5.1 format multichannel audio track
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Multichannel audio tracks are not required to mix 
in multichannel formats. Mono, stereo, and all sup-
ported track formats can be mixed using Pro Tools 
track outputs and sends (see “Multichannel Signal 
Routing” on page 1072).

Placing Audio in Multichannel 
Tracks

You can drag audio files and clips from Workspace 
browsers, the Clip List, Windows Explorer, or 
Mac Finder, or from other tracks, to place them in 
multichannel audio tracks.

To do so, the number of channels being dragged 
must match the destination track format. For ex-
ample, you can only drag a stereo pair or two mono 
clips onto a stereo audio track. Similarly, you can 
only place audio into an LCR track when you have 
selected three clips. With 5.1 tracks, you must se-
lect six mono files or clips. 

Solo, Mute, and Gain in 
Multichannel Tracks and Paths

Stereo and multichannel tracks consist of multiple 
audio signals, linked together. By default, multi-
channel tracks are linked and are controlled by a 
single channel fader, and solo and mute switches. 

For discrete control of signals, multichannel tracks 
can be converted into individual mono tracks. For 
discrete level and phase adjustment, you can insert 
and unlink a multi-mono Trim plug-in. Both of 
these techniques are explained below.

To convert a multichannel track into discrete mono 
tracks:

1 Select the multichannel track.

2 Choose Track > Split Into Mono. 

To have discrete control of gain on individual 
channels of a multichannel track: 

1 Insert a multi-mono Trim plug-in on the multi-
channel track.

2 Unlink the Trim plug-in by clicking the Link 
icon so that it is unlit. 

3 Use the Channel selector to display the controls 
for a channel, and adjust the gain. 

When dragged into a multichannel track, au-
dio files are placed from top to bottom in the 
exact order that they appear in the Clip List 
or playlist from which they came (Top to Bot-
tom must be selected for in the Clip List menu 
> Timeline Drop Order). For this reason, 
you may want to rename audio files before 
dragging them, so that they are placed in the 
preferred order. Rename them so that sorting 
them By Clip Name in the Clip List results in 
the preferred order. (For example, with a 
5.1-format track, you can rename the audio 
tracks so that the arrangement of the tracks 
corresponds to L, C, R, Ls, Rs, and LFE.)

Once converted to mono, multichannel tracks 
cannot be relinked into their original multi-
channel format. However, a multichannel 
track can be reassembled by dragging the 
corresponding number of mono files (with the 
appropriate file suffixes) into a multichannel 
track, although some automation data may 
be lost. As an alternative, record the submix 
of the mono tracks to disk on a multichannel 
track.

See “Linking and Unlinking Controls on 
Multi-Mono Plug-Ins” on page 1074 for 
more information. 
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Track and Output Formats

When you create new tracks, you specify mono, 
stereo, or a supported multichannel format for the 
new tracks. 

In the Mix and Edit windows, the track format of a 
track’s output is always visible by the number of 
track meters contained in its fader strip (for exam-
ple, a single meter for mono tracks, a pair of meters 
for stereo tracks, and six meters for 5.1 tracks).

Assigning track output determines the format of 
that output. For example, a mono track always has 
a single track meter, even when assigned to a ste-
reo output path. If that same mono track is assigned 
to a 5.1 output path, it's output will be split among 
those six output channels, depending on the posi-
tion of its panner. 

Changing Format

Changing the output format for a given track has 
several effects:

• The panner that appears in the track will change 
to reflect the new output format.

• It may be necessary for one or more pan related 
automation playlists to be created or deleted.

Because changing the output format has these ef-
fects, a warning dialog appears whenever you 
change the output format of a track to a format of 
fewer channels. Specifically, this will occur when-
ever automation playlists will have to be deleted.

Multiple Output Assignments and Track Format

When a track is assigned to more than one path of 
differing formats, the main output for that track 
will match the format of the assigned path with the 
greatest number of channels.

Multiple Outputs and Automation Playlists

When a track has multiple output assignments, 
Pro Tools sorts panning data appropriately for 
each assigned path. For example, if you assign a 
mono track to a stereo path and a 5.1 path simulta-
neously, that track will have a 5.1 panner in the 
Mix or Edit window. When you pan the track, 
Pro Tools interprets the 5.1 panning moves into 
stereo panning moves. 

This provides a type of parallel mixing. You can 
create a variety of mixes of differing formats all at 
the same time by routing your elements to multiple 
paths. 

Command-Control-click (Mac) or Control-
Start-click (Windows) any control in an Out-
put window to show its automation playlist 
in the Edit window and view any pan auto-
mation. 



Pro Tools Reference Guide1072

Multichannel Signal Routing

To mix in a multichannel format, tracks are as-
signed to multichannel paths. 

Tracks can be mixed in surround using the follow-
ing two methods:

• By setting a track main output to a multichannel 
path. 

• By assigning a multichannel send to route audio 
to a multichannel path. 

Multichannel Track Outputs

Tracks can be routed to multichannel output or bus 
paths using the track’s Output Path selector. This 
provides a multichannel panner and meter in the 
Mix and Edit window I/O View. 

Additional output assignments can be added by 
Start-clicking (Windows) or Control-clicking 
(Mac) the Selector tool and assigning another path. 

Two different ways to configure tracks for multichannel 
mixing

Multichannel output 
path

Multichannel send
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Multichannel Sends

All track formats, including mono and stereo, let 
you assign one or more multichannel sends. This 
provides a multichannel panner in the Sends View. 
Sends are also useful to bus tracks for multichan-
nel plug-in processing. 

The following figure shows a mono audio track 
with a 5.1 (6-channel) send (View > Sends A–E > 
Send A).

Pro Tools bussing and submixing features are 
available for all channel formats, from mono/ste-
reo through 8-channel. For examples of multichan-
nel monitoring, effects processing, and bussing, 
see “Mixing with Paths and Sub-Paths” on 
page 1075. For mono and stereo mix examples, see 
Chapter 43, “Basic Mixing.” 

Multichannel Auxiliary Inputs 
and  Master Faders

A multichannel Auxiliary Input or Master Fader is 
used as a return for the multichannel bus. Sends are 
useful when you need to create an additional, inde-
pendent mix simultaneously (perhaps of a distinct 
format), requiring dedicated fader, mute, solo, and 
automation controls.

You can assign Master Faders to main and sub-
paths. Main paths must match the format of the 
Master Fader, and only one Master Fader can be 
active and assigned to any single (active) main or 
sub-path. A Master Fader cannot be assigned to a 
sub-path if its associated main path is already as-
signed on another Master Fader. See “Master 
Fader Tracks and Signal Flow” on page 906. 

Multichannel Instrument Tracks

Multichannel tracks can be used to monitor and 
route multichannel instrument plug-ins or multi-
channel external MIDI instruments.

A mono audio track with a mono output format and a 
multichannel send

Multichannel send panner

Mono meter

Mono output format
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Mono, Multi-Mono and 
Multichannel Plug-Ins

Plug-Ins can be used in mono, multi-mono, or mul-
tichannel formats.

For information about mono, stereo, and mono-
in/stereo-out plug-ins, see Chapter 44, “Plug-In 
and Hardware Inserts.”

Multi-Mono Plug-Ins Are designed for use on ste-
reo or greater-than-stereo multichannel tracks. 
Multi-mono plug-ins are useful, or required, in the 
following situations: 

• When a plug-in does not involve multichannel 
correlated processing (for example, when apply-
ing EQ to select sides of a multichannel signal)

• When you need to adjust signals within the mul-
tichannel track independently

• When a plug-in does not support multichannel 
formats

When a multi-mono plug-in is first inserted on a 
multichannel track, the plug-in controls are linked. 
You can unlink them for independent adjustment. 
See “Linking and Unlinking Controls on Multi-
Mono Plug-Ins” on page 1074 for more informa-
tion.

Multi-mono plugs-ins can also be inserted on ste-
reo tracks, to apply unlinked plug-ins on the left 
and right channels.

Multichannel Plug-Ins Are designed for use on 
stereo and multichannel tracks that require cor-
related processing, including stereo and multi-
channel limiting, compression, and similar effects. 

Linking and Unlinking Controls 
on Multi-Mono Plug-Ins

When a multi-mono plug-in is used on a multi-
channel track of more than two channels, the con-
trols are normally linked. Adjusting the Gain con-
trol on one channel, for example, will adjust it for 
all channels.

If necessary, you can unlink plug-in controls on 
specific channels of a track and edit them inde-
pendently. You can also selectively link the con-
trols of specific channels. 

For example, to apply equal filter cutoffs to the Ls 
and Rs (surround) channels in a 5.1 mix, you could 
link enable just those channels in an unlinked, 
multi-mono EQ plug-in. Adjusting the controls in 
the plug-in window for either channel (Ls or Rs) 
adjusts the other, linked channel as well. 

Channel Selector Accesses a specific channel 
within a multichannel track for plug-in parameter 
editing. This menu appears only on multi-mono 
plug-ins inserted on tracks with more than two 
channels. 

Master Link Button When enabled, links the con-
trols on all channels of a multi-mono plug-in so 
that they can be adjusted in tandem.

Channel selector and Link controls

Channel selector
Link Enable buttons

Master Link button
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Link Enable Buttons Let you selectively link the 

controls of specific channels of a multi-mono plug-

in. Each square represents a speaker channel. The 

Master Link button must be disabled to use the 

Link Enable buttons. 

To unlink controls on a multi-mono plug-in:

� Deselect the Master Link button. It is lit when 

linked, unlit when unlinked.

To access controls for a specific channel:

� Select the channel from the Channel selector.

To open a plug-in window for all channels of a 
multi-mono plug-in:

� Alt-click (Windows) or Option-click (Mac) the 

Channel selector. 

To link the controls of specific channels:

1 Deselect the Master Link button if it is not al-

ready deselected.

2 Click the Link Enable buttons for the channels 

whose controls you want to link.

Paths in Surround Mixes

Because Pro Tools provides a flexible routing and 

submixing environment, you can maximize your 

system’s available resources by first identifying 

the elements that you want to pan dynamically and 

those that can be placed in certain channels only 

(see “Mixing with Paths and Sub-Paths” on 

page 1075).

Once you have identified these elements in your 

session, you can use a combination of main and 

sub-path assignments, and multichannel panning.

Mixing with Paths and Sub-Paths

It is rare that every track needs to be “flown” (ac-

tively panned in between more than a pair of 

speakers). In most situations, certain elements are 

placed in certain speakers and remain there, pro-

viding the foundation for a mix.

The following figure illustrates an example of how 

panning and signal routing can be combined in a 

multichannel mix. 

When to Use Assign Multichannel Outputs

� Assign 5.1 paths only to those tracks that need 

to be panned to all six channels. 

For example, a sound effects track with a jet fly-

over should be assigned a 5.1 path to fly the sound 

from front-to-back. In a music mix, you can fly a 

solo instrument or make a synth pad swirl around 

the room as a special effect. 

Elements that need to be heard in all speakers si-

multaneously can also be assigned to the multi-

channel output, whether or not they require active 

panning in the sound field. 

When to Use Sub-Paths 

� To help simplify large sessions, use sub-paths to 

route static (or, stationary) elements directly to 

the output channel or channels. 

For example, film dialog is often mixed to the cen-

ter channel to anchor this essential sound element 

to the picture. Instead of assigning a six-channel 

panner to dialog tracks and panning the tracks to 

the center speaker only, you can route the dialog 

track’s main output to a mono (Center) sub-path.

See “Extending Stereo Mixing Conventions 
to Surround Mixing” on page 1079 for re-
lated information. 
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Using signal routing and sub-paths to mix in surround

Effect 
bus routing

Outputs to
sub-paths

Outputs to main 5.1 path for surround panning

Tracks routed to main
5.1 surround path

Tracks routed to subpaths Auxiliary Input
routed to 5.0 
sub-path
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Extending Stereo Mixing 
Conventions to Surround Mixing

Stereo mixing sets the precedent for active and 
static panning, and surround mixing can benefit 
from the same basic principles. 

Panning a sound back-and-forth between the left 
and right speakers is best used as a special effect. 
In a typical music mix, the basic tracks are placed 
in the stereo sound field and remain there. 

Surround mixes can become incoherent if too 
many elements are continuously moving, For spe-
cial effects, some tracks can be panned dynami-
cally, bouncing between speakers or sweeping 
from one side to the other.

Example Paths and Signal 
Routing for a Surround Mix

Signal routing is the key element in any Pro Tools 
surround session. Signal routing is configured and 
defined in the I/O Setup dialog.

The examples that follow show how Auxiliary In-
puts, Master Faders, and other Pro Tools signal 
routing features can be used for stem mixes, sub-
mixes, and similar project needs. 

In these examples, music and effects are being 
mixed for a trailer, in 5.1 surround. Separate stem 
mixes (for music and for effects) are to be mas-
tered to 8-track MDM.

Example Output Paths

The following figure shows output paths defined in 
the I/O Setup dialog of an example session that 
was created on a Pro Tools|HDX system with an 
HD OMNI audio interface.

Different Output paths have been defined for Mix, 
FX, dialog, and Music.

Example Bus Paths

The following figure shows example bus paths.

An LCR format path (“Dialog”), a stereo format 
path (“Music”) and a 5.1 format path (“FX”) have 
been defined, each with several their own sub-
paths.

I/O Setup, example output paths

I/O Setup, example bus paths
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Example Sub-Paths

Sub-paths let you route to selective channels 
within the multichannel surround output. In the 
following figure, the Surround bus has several sub-
paths that show this. 

LCR Sub-Path The forward 3-channel sub-path. 
Use this type of sub-path routing to mix dialog, or 
other forward-facing sound effects. 

Stereo Sub-Path The forward stereo sub-path. Use 
this type of sub-path routing to mix music stems 
and effects to the front left and right speakers. 

Center Sub-Path The front center-channel sub-
path provides a discrete mono path for the center 
channel.

Ls/Rs Sub-Path The surround, rear left and right 
stereo sub-path. Use this type of sub-path to mix 
surround effects. 

LFE Path The LFE sub-path provides a discrete 
mono path for the LFE channel. 

5.0 Sub-Path The 5.0 path is a 5-channel sub-path. 
Use this type of sub-path routing to conserve mix-
ing resources with tracks you want to keep out of 
the LFE channel.

I/O Setup, example sub-paths
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Signal Routing Examples

The following examples show how main and sub-
paths can be used, using an example session con-
sisting of a 5.1 main mix, with music and effects 
stems (or submixes). 

Submix Stem Examples

The following figure shows a routing configura-
tion for an effects submix. Two tracks are routed to 
stereo bus sub-paths, while others are assigned to 
an LCR and a mono bus sub-path. Two tracks (one 
mono, one stereo) are assigned to multichannel 
busses for surround panning. A 5.1 Auxiliary Input 
assigned to the FX main bus path serves as a sub-
mixer. 

Extending Stereo Mixing Conventions to 
Surround Mixing

Stereo mixing sets the precedent for active and 
static panning, and surround mixing can benefit 
from the same basic principles. 

Panning a sound back-and-forth between the left 
and right speakers is best used as a special effect. 
In a typical music mix, the basic tracks are placed 
in the stereo sound field and remain there. 

Surround mixes can become incoherent if too 
many elements are continuously moving, For spe-
cial effects, some tracks can be panned dynami-
cally, bouncing between speakers or sweeping 
from one side to the other.

FX stem
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The following figure shows a routing configuration for music tracks.

Most of the music tracks in this example are routed 
to the front left/right channels, using a stereo sub-
path. A 5.1 Auxiliary Input controls the bus and 
stem output. 

Multiple Output Assignments

Multiple output assignments make it possible to 
configure a number of multi-format mixes. For ex-
ample, you can assign an additional stereo output 
to tracks and create a stereo mix at the same time as 
a 5.1 mix. For more information, see “Multiple 
Output Assignments” on page 917.

LFE Examples

LFE tracks and other audio can contribute to the 
LFE output in two ways:

• Using the LFE fader in Output windows. This 
LFE signal is post-fader. 

• Using a custom sub-path to route channels dis-
cretely.

Music stem
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The following figure shows a channel Output win-
dow, sending and metering the LFE channel. 

Using the LFE fader, you can add any amount of 
any multichannel path to the overall LFE output. In 
the above example, the track’s Center percentage 
has been turned off, and the LFE fader has been 
raised to route it to the LFE channel. 

The following figure shows how a “traditional” 
LFE track can be routed to only the LFE channel. 
This example uses a custom-defined LFE sub-path 
to the FX main bus path. 

LFE and Filtering

Pro Tools applies no filtering to LFE signals. 
Some delivery requirements may require filtering 
for the LFE track.

LFE fader

Discrete LFE routing, with main output to mono LFE 
channel

LFE faders can follow Mix and Edit Groups. 
For information, see “Selecting Group Attri-
butes” on page 251.

For instructions on creating a sub-path, see 
“Custom Multichannel Paths” on page 1065. 
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Chapter 49: Surround Panning and Mixing

Before you can pan a track in surround, it must be 
assigned to an appropriate multichannel output or 
bus path. 

The I/O Setup dialog defines the busing and output 
architecture of the Pro Tools multichannel sur-
round mixer. If you have not already done so, it is 
recommended that you become familiar with main 
and sub-paths and the I/O Setup dialog before 
starting multichannel Pro Tools projects. 

Introduction to Pro Tools 
Surround Panning
(Pro Tools HD Only)

There are four different track panning methods 
available: 

• In the Edit window, using the reduced-height 
Panner Grid in the I/O View

• In the Mix window, using the reduced-height 
Panner Grid

• In the Output window, using the full-size 
Panner Grid

• Through pan automation editing

Certain Pro Tools control surfaces provide addi-
tional panning options. See the documentation for 
your control surface. 

See Chapter 47, “Pro Tools Setup for Sur-
round” for more information on multichannel 
configurations and I/O Setup options. For 
multichannel signal routing, see Chapter 48, 
“Multichannel Tracks and Signal Routing.”

Multichannel surround mixing is supported 
with Pro Tools HD only.
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Mix and Edit Window Panner 
Grids

In the Mix and Edit window, multichannel Panner 

Grids are displayed on tracks that have multichan-

nel track or send output assignments. 

To pan from the Mix or Edit window:

1 To pan in the Edit window, make sure I/O View 

is being shown (View > Edit Window > I/O). Pan-

ner Grids are always displayed in Mix window 

tracks that support panning.

2 Begin playback. 

3 Drag in the appropriate multichannel track’s 

Panner Grid in the Mix or Edit windows. 

The Pan Location cursor follows your movements 

as long as you hold the mouse button. Movements 

are scaled so that, once you click to “grab” the Pan 

Location cursor, you do not need to limit your 

movements to the small Track Grid area. 

Pan Location Cursor Color while Automating

The Pan Location cursor is green when the track is 

in Automation Read mode, red in an Automation 

Touch, Latch, Touch/Latch, or Write modes, and 

yellow in Automation Off (or Automation Sus-

pend) mode. 

In Trim mode, the Volume fader and LFE fader are 

yellow.

Output windows provide additional features and 

controls (and a much larger Grid). For details, see 

“Output Windows” on page 1084. 

Output Windows

Output windows provide panning controls (called 

panners), as well as standard Pro Tools controls, 

for tracks of all mix formats (from 3-channel LCR 

through 8-channel 7.1). 

For information on Output window standard con-

trols, see “Standard Controls” on page 1085. For 

information on Output window panning controls, 

see “Surround Panner Controls” on page 1086.

Some of the features of Output windows include:

• X/Y (joystick-style) panning

• 3-Knob panning

• Full Divergence and Center Percentage control

• AutoGlide

• LFE feed

• Multichannel meters

• Pro Tools target window support

Multiple panners can be opened simultaneously, or 

a single window can display the current panner.

Drag to pan in the Track Grid
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To open an Output window:

� Click the Output Window button (the small 

fader at the right edge of the Output selector for 

a track in the Mix or Edit window (I/O View).

Standard Controls

All Output windows provide standard Pro Tools 

controls for routing, path assignment and other 

track features. These controls are located at the top 

of all Output, Send, Insert, and Plug-In windows 

(see “Standard Selector Controls in Output Win-

dows” on page 931).

Track Fader, Solo, Mute, and 
Auto

All Output windows provide track volume and 

mute controls. You can adjust and automate track 

volume, or mute, directly using these controls. The 

larger fader and Mute button are equivalent to 

those in the Pro Tools Mix window. 
Opening a multichannel Output window

For instructions on managing multiple Out-
put windows, see “Output Windows for 
Tracks and Sends” on page 928.

Panner Control section

Track selector

Output selector

Path selector Target icon
Show meters

Automation Safe
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Surround Panner Controls

When assigned to tracks or paths with four or more channels, the Output window provides an X/Y Grid for 
surround panning. The speakers associated with the panner’s multichannel format are displayed in their 
relative positions outside the Panner Grid. These speakers are also used as Snap Pan to Speaker controls.

This section identifies all the controls and features found in Pro Tools multichannel panners. 

Output window with a 7.1 format multichannel panner

X/Y Grid

LFE fader

Track fader and meter

Position 
(knob panners)

Divergence

Pan Location 
cursor

Panning Mode button

Track Automation. 
Solo, and Mute

Center %

Click to show meters

Snap Pan to Speaker icons
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The X/Y Grid and Pan Location 
Cursor

The X/Y Grid is where multichannel panning in-
formation is input and displayed. You can input 
pan information using X/Y mode, 3-Knob mode, 
or by entering numeric values in the Position data 
fields. You can also edit pan automation graphi-
cally in the Edit window.

Multichannel panners default to X/Y mode. In X/Y 
mode, the track’s current pan position is repre-
sented by a green dot. This dot is the Pan Location 
cursor, and its color indicates track automation sta-
tus using standard Pro Tools colors: 

Green The track is in automation Read mode.

Red The track is in automation Write, Touch, 
Latch, or Touch/Latch mode.

Yellow The track is in automation Off mode (or 
Automation Suspend) mode.

Panning Mode Button

This button, located below the X/Y Grid, provides 
access to Surround panning modes (see “Panning 
Modes” on page 1088). 

Position Controls

The Position controls let you set the positions of 
the panner.

Front Displays and controls the current front X-
axis (left/right) position of the panner. 

Rear Displays and controls the current rear X-axis 
(left/right) position of the panner. In default X/Y 
Panning mode, Rear is linked to Front position and 
cannot be controlled independently. 

F/R (Front/Rear) Displays and controls the current 
Y-axis position of the panner. 

Center % Control

Center % controls how much of the signal is routed 
to the center speaker. This lets you mix a track to 
the front with a phantom center (0% Center value) 
or to three-channel (LCR) when panning front. 

Divergence Controls

Divergence determines the width of the panned 
signal with respect to neighboring speakers. (For 
more information, see the Pro Tools Sync & Sur-
round Concepts Guide). There are three Diver-
gence controls:

Front, Rear, and F/R Divergence Provide sepa-
rate, automatable divergence control over front 
speakers, rear speakers, and between front/rear, 
respectively.

Snap Pan to Speaker Icons

The Snap Pan to Speaker icons let you force the 
panner to the speaker’s location. For example, 
clicking on the upper left speaker moves the Pan 
Location cursor to the upper left corner of the X/Y 
Grid.

LFE Fader

The LFE fader is only available in “.1” surround 
formats (5.1, 6.1, and 7.1). 

The LFE fader determines how much of the current 
track’s signal will be routed to the LFE channel. 
LFE faders in Track and Send windows can follow 
groups. The Pro Tools LFE channel is always full-
bandwidth. For more information on how to use 
the LFE fader, see “LFE Faders in Multichannel 
Panners” on page 1094.

For examples of how divergence settings 
affect output panning, see “Divergence and 
Center Percentage” on page 1091.
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Multichannel Panner Linking

Stereo tracks with multichannel outputs provide 
left and right multichannel panners. The Output 
window provides controls to link the left and right 
channels for precise panning.

When you create a stereo track that is routed to a 
multichannel output, the following pan linkage 
controls are active by default:

• Link (links Left and Right pan controls)

• Front Inverse (inverts Left and Right pan control 
linkage across front)

• Rear Inverse (inverts Left and Right pan control 
linkage across rear)

The Front/Rear Inverse pan control is unlinked by 
default. 

Panning Modes

The Panning Mode button provides access to four 
panning modes: X/Y mode, Divergence Editing, 
3-Knob mode, and AutoGlide mode. Panning con-
trols can be automated in all four modes.

Pro Tools provides the following Panning Modes:

X/Y Mode Joystick-style panning by dragging the 
Pan Location cursor within the X/Y Speaker Grid. 
See “X/Y Panning” on page 1088 for more infor-
mation.

3-Knob Mode Point-to-point panning, between 
pairs of speakers. See “3-Knob Panning” on 
page 1089 for more information. 

Divergence Editing The divergence X/Y Grid can 
be dragged to resize the divergence boundaries. 
See “Divergence Editing Mode” on page 1092. 

AutoGlide Mode Point-to-point panning from the 
Pan Location cursor to a new destination over a 
specified AutoGlide Time. See “AutoGlide Mode” 
on page 1090 for more information.

To enable a Panning Mode:

� Click on the Panning Mode button in the Sur-
round Panner until the mode icon is displayed.

X/Y Panning

To pan in X/Y mode:

1 Click on the Panning Mode button until the X/Y 
mode icon is displayed.

2 Drag the Pan Location cursor, or click any-
where in the Grid and drag to pan the track. The 
location of the Pan Location cursor determines 
the pan position of the signal. For example, to 
pan something to the left rear speaker, move the 
Pan Location cursor to the lower-left corner of 
the Grid. 

Stereo multichannel panner controls showing default 
linking

Link 

Front/Rear Inverse

Front Inverse

Rear Inverse

It is not necessary to click exactly on the Pan 
Location cursor. Clicking anywhere in the 
Grid will move the Pan Location cursor rela-
tive to where you click or take over with a 
hardware panner. Panning does not jump to 
the click position. 
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To snap the Pan Location cursor to a location in 
the Grid:

� Control-Shift-click (Windows) or Command-
Shift-click (Mac) at the location in the X/Y 
Grid. 

Grid Options and Shortcuts

Fine-Adjust Mode Hold the Control key (Win-
dows) or Command key (Mac) for fine adjustment 
of all Panner controls. 

Constraining to X or Y Movement Shift-drag the 
Pan Location cursor to constrain its movement to 
the X or Y direction.

Reset to Default Alt-click (Windows) or Option-
click (Mac) in the Panner Grid to reset all controls 
to their default position. 

Snap Pan to Speaker Click one of the Snap Pan to 
Speaker icons to force the panner to that speaker 
location. 

Display Automation in Edit Window Control-
Start-click (Windows) or Command-Control-click 
(Mac) a control to display that control’s playlist in 
the Edit window.

3-Knob Panning

Pro Tools provides 3-Knob mode as an additional 
way to input pan moves. 

3-Knob mode lets you do the following:

• Pan in straight lines, moving the Pan Location 
cursor using the Position rotary knobs with full 
movement of front, rear, and front-rear position

• Pan discretely between pairs of speakers.

For example, when panning front-left to rear-right 
in 3-Knob mode, audio will be heard from just 
those two speakers (assuming full divergence is in 
effect). 

By comparison, in X/Y mode a diagonal pan may 
result in audio being heard in some or all channels. 

The difference is that 3-Knob mode pans discretely 
between the front and rear position of the panning 
trajectory, while X/Y mode panning takes place in 
the full 360° Panning Grid. Divergence and Center 
Percentage are variable in both Panning modes. 

To enable 3-Knob Panning mode:

� Click on the Panning Mode button until the 3-
Knob mode icon is displayed.

The panner trajectory line appears across the Grid, 
extending from the front (X-axis) to the rear (Y-
axis).

All Pan controls can be automated, including 
pan position and divergence. See Chapter 45, 
“Automation” for details. 

Panning and metering in 3-Knob mode

Panner Mode button set to 3-Knob mode

3-Knob trajectory

3-Knob mode
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To pan in 3-Knob mode:

1 Adjust the Front and Rear Position knobs to set 
the trajectory line. 

2 Rotate the Front/Rear Position knob to pan 
along the trajectory. The Pan Location cursor is 
constrained to the white trajectory line. 

To change the 3-Knob trajectory angles, do one of 
the following:

� Drag either end point (Front or Rear) of the tra-
jectory line. 

� Adjust the Front or Rear Position controls. 

To change the current trajectory position (left-to-
right) and retain its current angles:

� Drag the trajectory line (not its end points) to a 
new position. 

AutoGlide Mode

AutoGlide mode lets you quickly write Surround 
Panner automation by clicking new locations in the 
Surround Panner window, instead of manually 
moving the Surround Panner controls.

The time it takes to glide from point to point (from 
the Pan Location cursor to the new destination) is 
called the AutoGlide Time. This time is set in the 
Mixing Preferences page and has a range of 
10 msec to 10000 msec (10 seconds).

To set the AutoGlide Time

1 Choose Setup > Preferences and click Mixing. 

2 Set the AutoGlide Time in the Automation 
section.

To do an AutoGlide automation pass:

1 Click the Panning Mode button until the 
AutoGlide mode icon is displayed.

The Panning Mode button displays a slanted dotted 
line that ends with a filled in dot (representing a 
cursor) at its top right corner.

2 In the Mix or Edit window, click the Automa-
tion Mode selector and select an Automation 
mode for the track you want to automate.

3 Press Play to begin playback.

4 Set a new destination for the cursor by doing 
one of the following:

• Click a Snap Pan to Speaker icon to glide to its 
speaker location.

• Click in the pan window to glide to a specific lo-
cation in the X/Y Grid.

When writing automation in AutoGlide 
mode, the Pan Location cursor cannot be 
dragged from its location.

Panner Mode button set to AutoGlide mode

Panning Mode button (AutoGlide mode shown)

AutoGlide mode

Snap Pan to 
Speaker 
icons

Pan Location 
cursor
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The Pan Location cursor will begin to move to-
wards the new destination in the time it takes to 
travel the AutoGlide Time. When the new destina-
tion point is reached, a new breakpoint will be 
written at the new location.

5 Repeat the previous step if you want to write ad-
ditional panning moves.

6 Stop the transport when finished.

Divergence and Center 
Percentage

The Divergence and Center Percentage controls 
range from 0 to 100, and can be automated. They 
are especially useful for ensuring audibility and 
coverage in large venues, and to increase clarity of 
voices. 

Front Divergence Controls divergence between 
front speakers (X-axis only). 

Rear Divergence Controls divergence between the 
rear speakers (X-axis only).

Front/Rear Divergence Controls divergence be-
tween front and rear (the Y-axis).

Center % (Percentage) Determines whether there 
is a discrete center image, a completely phantom 
center image, or a variable amount in between. 

Side % (Percentage) Determines whether there is 
a discrete side image, a completely phantom side 
image, or a variable amount in between the right 
and left side channels for 7.1 and 7.0 formats. 

Divergence

In the Panner Grid, the current divergence values 
are displayed using a purple outline. 

By default, Pro Tools surround panners are 100% 
or fully divergent, meaning that a signal that is 
panned completely to one speaker will only be au-
dible in that speaker. 

Divergence display and controls

Divergence display

Divergence controls



Pro Tools Reference Guide1092

Lower divergence settings result in a progressively 
wider source signal. When Divergence is less than 
100%, tracks will be routed to neighboring speak-
ers to some degree, even when the Pan Location 
cursor is positioned next to a single speaker. 

To adjust divergence:

� Adjust the Front, Rear, and Front/Rear Diver-
gence controls as necessary. 

Divergence Editing Mode

In Divergence Editing mode, you can adjust the di-
vergence boundaries by dragging directly in the 
Divergence Grid. 

To adjust divergence graphically:

1 Click on the Panning Mode button until the 
Divergence Editing icon is displayed.

2 Drag in the Grid to resize the divergence bound-
aries. 

Front Divergence at less than 100% for wider panning

Front
Divergence

Pan Location 
cursor

Panner Mode button set to Divergence Editing
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Center % (Percentage)

In LCR, LCRS, 5.0, 5.1, 6.0, 6.1 7.0, 7.0 SDDS, 
7.1, and 7.1 SDDS surround formats, the Center % 
controls whether there is a discrete center channel 
for the track or a phantom center channel. 

Center Percentage Example

In film and video production, the center channel 
often contains dialog. To enhance the clarity of di-
alog, it is often beneficial to keep elements such as 
music out of the center speaker. By reducing the 
Center Percentage on music tracks, music panned 
to the front of the soundfield can be panned to only 
the left and right speakers, forcing them to have a 
variable phantom center image.

To adjust Center Percentage:

� Adjust the Center Percentage knob.

As you reduce the Center Percentage value, the 
center speaker at the top of the Grid becomes less 
visible. At 0, the center speaker is completely in-
visible, reflecting the setting for fully phantom 
center.

Side % (Percentage)

For 7.1 and 7.0 surround formats, the Side % con-
trols whether there are discrete side channels for 
the track or a phantom side channel. 

To adjust Side Percentage:

� Adjust the Side Percentage knob. 

As you reduce the Side Percentage value, the 
speakers at the sides of the Grid become less visi-
ble. At 0, the side speakers are completely invisi-
ble, reflecting the setting for fully phantom center.

Center % set to 0 (no center speaker shown)

Side % set to 50% (side center speakers dimmed)
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LFE Faders in Multichannel 
Panners

The LFE fader controls how much of the track is 

sent to LFE. LFE faders are only available when a 

track is assigned to a path whose format supports 

LFE (5.1, 6.1, or 7.1). 

To mix to the LFE channel:

� Adjust the LFE fader in any “.1” surround for-

mat Output window. 

LFE Faders and Groups

Track and send LFE faders can follow Mix and 

Edit Groups by being enabled in the Group Attri-

butes page in either the Create Groups or Modify 

Groups dialog. LFE faders can be assigned to fol-

low groups as a global attribute or on a group by 

group basis. See “Selecting Group Attributes” on 

page 251.

LFE Enable

Some multichannel plug-ins, including the multi-

channel Dynamics III Compressor/Limiter, pro-

vide LFE Enable. This lets you enable or bypass 

processing of the LFE channel if present. 

To process the LFE channel in a multichannel 
plug-in:

� Click to enable LFE Enable in supporting mul-

tichannel plug-ins. LFE Enable is highlighted 

when LFE processing is enabled, and unhigh-

lighted when LFE processing is bypassed.

Pan Playlists

Multichannel panners have an automation playlist 

for each position and divergence control. 

For general information about LFE, sub 
channels, and related topics, see the 
Pro Tools Sync & Surround Concepts Guide.

LFE Enable in the multichannel Dynamics III 
Compressor/Limiter

When LFE Enable is unavailable, try using 
the multi-mono version of the plug-in.

Pan automation can be drawn, edited, cut, 
copied, and pasted from the Edit window. 
For more information, see Chapter 45, 
“Automation.”


